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Autodesk, Inc. 

Speaker Biography 

Based in Lake Oswego, Oregon, Andrew Sears is a quality assurance engineer working on Autodesk 
Nastran In-CAD software. He was designing heavy equipment for the mining and aggregate industries 
for 6 years before coming to Autodesk, Inc., in 2011. He has spent most of his time designing assemblies 
with over 10,000 parts, so he brings some practical knowledge of designing large assemblies and 
creating simulations. Andrew is well connected to the engineering community in the Portland Metro area 
and has been president of the local Inventor User Group for over 6 years. 

Learning Objectives 
 Learn about FE model setup and analysis 

 Learn about results and post-processing  

 Learn about FE model setup with advanced analysis types 

 Learn about advanced results and post-processing 

Description 
This lab will focus on getting started with Autodesk Nastran In-CAD software inside of Inventor 2016 
software. Participants should have an understanding of finite element analysis (FEA) and the preferred 
participants are currently using FEA in their jobs. We will explore the Ribbon, Browser, and different 
analysis types. We will have a few workflows for basic users that are looking to crest the initial hurdle 
when learning new software, as well as a few examples for the more advanced users who are familiar 
with FEA software. 

Your AU Experts 
Mitch Muncy is a simulation enthusiast with over 15 years in the computer-aided engineering industry. 
Before joining Autodesk, Inc., as a product manager, he was executive vice president of NEi Software (NEi 
Nastran), where he managed day-to-day operations of the Sales, Marketing, and Technical Teams. Mitch 
holds a degree in mechanical engineering from the University of California, Irvine. 

 

Wasim Younis is a Simulation Solutions manager at Symetri, with more than 20 years of experience in 
the manufacturing field, including working at Rolls Royce, British Aerospace, and Nuclear Electric. He has 
been teaching at AU for more than 5 years. Wasim has been involved with Simulation software from 
Autodesk since the company first introduced it, and he is well known throughout the worldwide Autodesk 
Simulation community. He authored the Up and Running with Autodesk Inventor Simulation books, 
which are available via Amazon. He also runs a dedicated forum for simulation users on LinkedIn: Up and 
Running with Autodesk Inventor Simulation 
 
Andrew Sartorelli is a 2012 graduate of the University of New Hampshire, with a bachelor’s of science in 
mechanical engineering. He went on to work for a number of small companies using computational fluid 
dynamics software to optimize power consumption in the data center and mission critical facility field. 
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Andrew has been with Autodesk, Inc., since the Fall of 2013 as a technical support specialist for 
Simulation Mechanical software, most recently acting as knowledge domain expert for Autodesk Nastran 
software and Autodesk Nastran In-CAD software. 
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Learn About FE Model Setup and Analysis

Small Block 
Let's take a small block example to become familiar with the In-CAD user interface.   

User Interface 
 

Step: 

We will use this small, simple block as the starting point to help you focus on the user interface 
for In-CAD.  If you are not familiar with Inventor, open the Small Block folder and double click 
the [Small Block.ipj] file to launch Inventor. 

Step: 

Open [Small Block.ipt] 

Step: 

Switch to the In-CAD environment.  Select the Environments tab and select the Autodesk 
Nastran In-CAD icon.  Once you enter the In-CAD environment, you will notice the CAD model 
material is imported and used to define the Finite Element (FE) Physical Properties and is added 
to the FE model.   

 

 

 

Now let’s discuss the In-CAD Browser.  The In-CAD Browser can be thought of as 4 high level 
parts.  The items in the Browser will be referred to as nodes. 

- 1 is the Analysis node. 
- 2 is the Finite Element (FE) Model node. 
- 3 is the analysis Subcase node. 
- 4 is the Model node.  
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The Analysis node can be used to define the Analysis Type and high level modifications to the 
active analysis.  The FE Model node handles mesh and Physical Properties.  Subcases are used to 
break the analysis into steps.  A good example for adding additional Subcases would be a 
multiple stage loading scenario like a car suspension.  The car suspension is initially loaded with 
the weight of the vehicle and a second subcase could be used to simulate multiple external 
loads to the suspension, like a speed bump.  The Model node will hold all of the information for 
every analysis.  Items under the Model node can be edited with the changes showing in all 
Analyses. 

 

With the part open now, let’s start with a basic linear static analysis.  Linear static is the default 
analysis type for every new analysis created.   

Step: 

Start by generating the mesh.  In the Ribbon, select Generate Mesh in the Mesh Panel.  This will 
use the default settings to generate the mesh and create the Nastran file. 
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Step: 

In the Ribbon, select Constraints. 

 

Step: 

Pick one of the end faces on the part to define this as having a fixed constraint and select OK.  
You will notice the Selected Entities area is showing the face you selected.   

NOTE: Multiple faces, edges and vertices can be selected and will show in the Selected Entities 
dialog.  The default option for constraints is fixed.   
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Step: 

In the Ribbon, select Loads. 

 

Step: 

Add a 1 lbf load to the top face in the Y-Direction.  

NOTE:  The default option for Load is Force.  Pick one of the faces on the part to define this as 
having a load and type in a value for Fx, Fy, or Fz and select OK.  You will notice the Selected 
Entities area is showing the face you selected.   
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Now you should have the model ready to solve. 

Step: 

In the Ribbon, click Run. 

 

When the analysis is finished, select OK to start reviewing your results. 
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At this point, you will see the results are showing in the Browser. 

 

 

To review any of the results, double click on one of the default result types you are interested in.  
Your results might be slightly different from the images shown. 
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Results values are shown in the legend on the left side.  At the bottom left you will see high level 
information about the results you are viewing. 

 

Now you have finished the basic introduction to In-CAD!  You can leave Inventor open if you 
want to review this model later.  If you are comfortable, save and close the model then close 
Inventor.  The next walkthrough will cover a slightly more complicated analysis of an assembly 
with contacts along with more post processing options. 

 

Learn About FE Model Setup, Analysis and Post Processing of an Assembly

Leaf Spring 
Let's use a Leaf Spring example to become familiar with assembly analysis.  If you are not familiar with 
the user interface of In-CAD, please go back to the small block example or ask one of the experts in the 
room.   

 

Step: 

We will use a leaf spring for this walk though.  The focus for this section is to help you become 
familiar with defining contacts.  Open the Leaf Spring folder and double click the [Leaf 
Spring.ipj] file to launch Inventor. 

Step: 

Open [Leaf Spring-New.iam] 

Step: 

Switch to the In-CAD environment.  Select the Environments tab and select the Autodesk 
Nastran In-CAD icon.   
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Editing the Active Analysis 
 

Step: 

Let’s review and change some of the default analysis settings.  In the Ribbon, select Edit to open 
the active analysis settings. 

 

In this dialog, you will see: 

- Type – Defines the analysis you want to run. 
- Output Controls – Defines the data you want available for post-processing. 
- Options – Defines the contact type and tolerance. 
- Model State – Allows you to take advantage of Inventor Representations Level of Detail 

(LOD) and Design Views. 

 

 

Step: 

Select the Options tab and change the Contact Type to Sliding/No Separation with a Tolerance 
of 1mm.  Hit OK to apply these changes.  
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Meshing 
 

Step: 

Let’s take a look at the mesh.  In the Ribbon, select Mesh Settings. 

 

This will open the Mesh Settings dialog and you can verify these settings or change so they 
match the data below. 

- Set Element Size to 5mm 
- Verify Element Order is set to Parabolic 
- Uncheck Continuous Mesh if checked 
- Hit OK to generate the mesh with these settings 

 

NOTE: Continuous meshing will merge all external nodes between solid elements that are within 
the Tolerance specified in the Mesh Settings.  In this example, we will need these mesh nodes to 
be free since we will be defining a sliding contact below. 

 



BAM! – Let’s Throw a Little In-CAD into your Simulation 
Soup 

 
 12 

 

 

 

 

Contacts 
 

Step:  

In the Ribbon, select Automatic in the Contacts Panel.  This will generate all of the 
Separation/No Sliding contacts between Geometry that is within the contact tolerance. 

 

 

 

You should see the Surface contacts are now populated in the Browser. 



BAM! – Let’s Throw a Little In-CAD into your Simulation 
Soup 

 
 13 

 

 

 

Now let’s add a Manual Bonded contact to hold the center hole of the suspension.  This will act 
like a bolt holding the springs and sandwich plates together and keep things from flying apart 
during the analysis. 

Step: 

To make this easier to view, keeping the In-CAD environment active, select the View tab in the 
Ribbon and choose Half Section View from the appearance Panel.  Pick one of the outside faces 
and move the slider until you can clearly see the center holes of the springs and sandwich 
plates. 

Step: 

Click the green checkmark if you like the way the section view looks. 
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Step: 

Switch back to the In-CAD tab and select the Manual icon in the Contacts Panel.   

Step: 

Change the Contact Type to Bonded.  Change the Contact definition to Manual.  Uncheck the 
Max Activation Distance box.  Click inside the Master Entity field and choose one of the 
sandwich plate holes.  This will be the starting point for the contact definition.  See the image 
below for reference. 
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Step: 

Now click in the Slave Entity box and pick the remaining center holes.  You should be selecting 
all of the leaf spring holes and the other sandwich plate hole.   

 

 

Step: 

Once you are confident the remaining holes are selected, click OK and save the model. 
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Step: 

Select the View tab and change this back to the full view by selecting End Section View.   

Step: 

Switch back to the In-CAD environment.   

 

Constraints 
 

Now let’s add constraints.  In this section you will add fixed constraints to the end pin and 
support to simulate the assembly in an installed configuration.     

Step: 

In the Ribbon, under the Setup Panel, select constraints.  

 

NOTE: The default setting is fixed, Structural constraint.  This can be applied to multiple faces, 
edges and vertices.   
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We added a selection filter that can be accessed by RMB in the Selected Entities box.  RMB in 
the Selected Entities box and choose Select Faces. 

 

Now select the 3 faces shown below.  These will be the two ends of the pin and the flat face of 
the Hook_Part.  Hit OK to apply the fixed constraint. 
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Constraint 1 is now added in the active Subcase under Constraints in the Browser. 

 

 

Loads 
 

Now let’s add a Load.  In this section you will add a load to simulate an upward force.  This will 
simulate the initial loading as if an axel was mounted and the trailer placed on the ground. 

Step: 

In the Ribbon, under the Setup Panel, select Loads.  See the image below and select the bottom 
face of the plate shown. 
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Step:  

Leave the Type as Force and the Coordinate System as the assembly.  Input 2000N into the Fy 
field to apply the load in the Global Y direction. 

NOTE: This will act as the trailer weight on one side of the suspension.   

Step: 

Change the color of the force and increase the Density and Size so the force is easier to see.   

NOTE: You will not see changes to the visual part of the load until you select OK. 

Step: 

Hit OK to apply the load and the changes to the Load display. 
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Bolted Connections 
 

In this section you will simulate a bolted connection.  The bolted connection will have a preload 
and will be used to idealize the connection between the suspension and the axel.   

Step: 

Expand the Model node in the Browser and look for Connectors. 
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Step: 

RMB on Connectors and select New. 

Step:  

When the Connector dialog opens, make these changes. 

- Set Connector Type as Bolt. 
- Preload as Axial with 400N. 

 

 

Now you can select the start and stop edges for the bolt.  For this example, the bolt head will be 
at the top of the plate and the nut at the bottom.  To add the top hole edge, click in the 
Connector dialog under bolt head and select the top hole edge shown below. 

 

 

To add the bottom hole edge, click in the window under nut and select the bottom hole edge. 
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This should give you a preview with the bolt head at the top and the nut at the bottom. 

 

 

Step: 

You will need to create 3 more bolt connectors.  Instead of hitting OK to apply this bolt 
connector, you can select the New icon at the bottom to create the first bolt and keep the dialog 
open to define the remaining 3 bolts.   

NOTE: The dialog will reset so be sure to select Bolt type again.  Use the same parameters from 
the above steps when defining the remaining three bolts. 
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That is it!  The model is ready to solve but I don’t want you to solve it because it takes about 10 
minutes.  To save time I have included the solved model.   

Step: 

Save the current model and close Inventor before reviewing the solved results.  

Step: 

Open the folder called [Leaf Spring-Solved] and browse for [Leaf Spring.ipj] to launch Inventor.  
Once Inventor launches open [Leaf Spring-Solved.iam] and switch to the In-CAD environment. 

Step: 

You will need to load the results.  To load the results, RMB on the Results node in the Browser 
and choose Load. 
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Step: 

You can view any of the results by double clicking on one of the result types.  You can also edit 
any of the default result plots that are shown.  RMB on one of the result types and select Edit to 
open the Plot Template. 
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NOTE: Think of the Plot editor as two sections.  The left side controls how you want to review 
the results and the right side controls what you want to see.  The right side will have a column of 
tabs that will expand to show more information.  To make the tab active, you only need to select 
it but to edit the information within the tab you will need to ensure the box is checked.  In the 
image below, Contour Options and Deform Options are the only two areas that you can modify 
because they have the box checked.  You can still view information in the tabbed areas, you are 
just not able to edit them until the box is checked.   

 

 

Play around with the Plot settings and ask questions to someone in the room if needed.  To help 
you get used to this, I created some steps below for you to edit the von Mises Plot. 

 

Step: 

Select the Deform Options tab and change the Deformation Scale to Actual.  Leave the 
Deformation Scale Value as 1 or play around with this to get a better feel of what it is doing.   

NOTE: For the Deformation Scale, you will have two options to control visualization.  These will 
be Percent and Actual.  The Percent value is calculated using the overall model geometry as the 
base for measuring while Actual value is a multiplier of the actual Vector selected.   
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NOTE: After making changes to the Plot template, you will need to select the Display icon to 
show these changes.  For performance reasons, we disabled dynamic loading of changes to the 
Plot.   

Step:  

After changing the Deform Options, select the Part View box to make it editable and it will 
become active.  Part View will allow you to select only the components in the model that you 
want to see results on.   

Step: 

Select the part named Hook and click on display.  You will see this part is now isolated for better 
viewing. 
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Step: 

Now Select the Visibility Options tab.  This area will remove what you see in canvas or add it 
back if you decide to view it later.   

 

NOTE: I highlighted the on/off selectable items on the right side in the image below.  These are 
dynamically controlled because they already exist on the model so no performance hit is seen 
when changing.   

 

 

Step: 

To edit these, click the button and the blue “light” will turn off indicating that you do not wish to 
see these visibility options on the model.   First make sure you have selected Display on the left 
side then select the button next to Element Edges to turn them off.  This will make viewing the 
results a little easier by removing the mesh from the display. 
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Step: 

Once you like the visualization, click on the Animate Options tab.  This will allow you to change 
the way the results are animated.  Change the Animation Options settings to match the image 
below and select the Animate icon on the left.  

 

 

Step: 

Click the Animate icon on the left again to stop the animation and hit OK to apply the changes to 
the Plot template. 
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NOTE: You can hit OK to apply the changes and the animation will continue to run.  To turn this 
off, RMB on the highlighted von Mises node under Results in the Browser and uncheck Animate 
to take you back to the FE model view. 

 

Let’s look at some additional ways to view the results.  It is sometimes easier to look at the 
results of a component by graphing the results along some feature of the component.  We will 
take a look at the stress along the edge of part Upper.ipt. 

 

 

Step: 

In the Browser, you will see a node called XY Plot in the active analysis.  RMB on the XY Plot and 
select New. 
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Step: 

Refer to the image below for the changes to make in the XY Plot dialog.  You can name this XY 
Plot for easier reference.  I called mine Stress along Upper Comp.  

Items to change: 

- Under General, change to Element. 
- Under Entity to Plot, change to Along Selected Entity and select the edge shown below. 
- Under Y-Axis Output Sets, use the dropdown, scroll towards the bottom and select SOLID 

VON MISES STRESS. 

 

 

Step: 

If your settings look like the image above, click Show XY Plot at the bottom of the dialog. 
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NOTE: You can place your mouse cursor over the graph to review the values.  Play around with 
some of the XY Plot settings to modify how the data is displayed.  For really skewed values, we 
have included Log plotting abilities to help visualize data that might have large differences in 
values. 

Step: 

Click OK to exit this dialog once you are happy with the way the data is displayed. 

Step: 

Click Save to add this XY Plot to your analysis and then select Close after the note pops up letting 
you know this has been added to the analysis. 

Step:  

Save your work and exit the In-CAD environment.  Do not close this model as you will use it in 
the next steps. 

 

 



BAM! – Let’s Throw a Little In-CAD into your Simulation 
Soup 

 
 32 

 

Creating Assembly Representations 
 

In this section you will look at creating Assembly Representations to review parts of the 
assembly individually.  You should be in the Assemble environment now.  This is easier than 
creating separate analyses on the individual parts because you can review everything from one 
file. 

Step: 

Expand the Representations folder in the Browser then expand Level of Detail.  RMB on the 
Level of Detail node and select New Level of Detail. 

 

 

Step: 

A new Level of Detail is created and the default name is LevelofDetail1.  Suppress all of the other 
components except for Hook.  If you are not familiar with Inventor or this functionality, let 
someone in the room know and they will show you how to do this step.   

Step: 

Save the model to apply to LOD changes. 
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Step: 

Go back into the In-CAD environment.  You should see your active analysis with all components 
shown because this was the model state set for this analysis.   

Step: 

In the Ribbon, select New to create another analysis of this model. 
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Step:  

When the Edit Analysis dialog shows up, select the Model State tab and change the Level of 
Detail to the one you created.  Select OK to apply this change. 

 

 

NOTE: A new analysis is created and the only component shown is Hook.  This will help you to 
review individual components in the context of the assembly. 
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Creating a New Physical Property 
 

Step: 

Select Physical in the Ribbon to create a new Physical Properties definition. 

 

 

NOTE: By default, if the check box next to Associated Geometry is unchecked, this will assume 
you want to apply this Physical Property to all active components in the analysis.   

NOTE: A physical Property was already defined for Analysis 1 and this could be reused.  Under 
the Model node in the browser, you can drag the existing Physical Property definition up into 
the FE Model.  For this example I wanted to show you how to create a new Physical Property. 

Step: 

Select the New Material icon. 

 

NOTE: In the Material dialog, you can create a new material with custom properties or add one 
from the database.  For this example you will use a material from the database. 
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Step: 

With the Material dialog open, choose Select Material in the upper left. 

 

Step: 

Select Iron – Cast under the Inventor Material Library. 
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Step: 

Click on OK to accept Iron-Cast and OK again to define and close the Material Dialog. 

 

NOTE: Some materials are missing information for Failure Theory, such as brittle failure, so we 
are letting you know with a popup after choosing a material.   

Step: 

Select OK to apply this definition. 

That is it!  You are ready to apply what you have learned to set up loads and boundary 
conditions then run a Linear Static analysis on this single part within the context of the main 
assembly.  Practice what you learned for a few minutes and ask someone in the room if you are 
stuck with something.  For example, you might want to know about side loading on this part.   

 

Learn About Model Setup and Modal Analysis

Modal Analysis 
Let's look at a simple support beam that will have a vibrating motor attached installed.   

 
We will use a small beam as a support for a vibrating motor as the starting point to help you 
focus on the model setup for this modal analysis.  In this workflow you will learn how to set up 
the model for Modal Analysis and idealize the vibrating motor as a concentrated mass.  The 
Concentrated Mass will be connected to the beam using Rigid Connectors. 



BAM! – Let’s Throw a Little In-CAD into your Simulation 
Soup 

 
 38 

 

Step: 

Browse to the folder Modal and double click [Modal.ipj] file to launch Inventor. 

Step: 

Open [Modal.iam] 

Step: 

Switch to the In-CAD environment.  Select the Environments tab and select the Autodesk 
Nastran In-CAD icon.   

NOTE: You will notice that two Physical Properties were automatically created and assigned to 
the FE Model because the CAD models have different material definitions.  One will cover the 
beam and end plates while the other will cover the vibrating motor base. 

Step: 

Select the Edit icon and change the Analysis Type to Normal Modes.   

 

 

Step: 

We will not be reviewing Stress in this workflow so you can uncheck Stress from the Elemental 
Output Sets. 
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Step: 

Switch to the Options tab.  By default the Contact Type is set to Bonded.  For this example, leave 
as bonded.  Select Ok to apply the changes to the active analysis. 

NOTE: Analysis1 has been updated and you should see Normal Modes with the addition of the 
Modal Setup shown under the Subcase. 
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Step: 

Double click the Modal Setup 1 node in the Browser. For this analysis you will use the default 
settings.  Select OK to close the dialog. 

 

 

Model Setup 
 

Step:  

To create contacts, select Automatic in the contacts Panel to create a bonded contact between 
the components.   

Step: 

Define a Fixed constraint to the four holes on each plate and select OK. 

Step: 

Now let’s replace the vibrating motor base with a Concentrated Mass.  Under the Model node in 
the Browser, RMB on the Concentrated Masses and select New. 

Step: 

Change the Type to Automatic and add the motor frame to the Selected Entities. 

Step:  

The Automatic option is asking for a density of the model.  Input the density as 0.008.   
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Step: 

Click OK to accept these settings.  Now you should see the motor frame is replaced with the 
Concentrated Mass icon. 

 

 

Step: 

Under the Model node, RMB on Connectors and select New. 

Step: 

Change the Connector Type to Rigid Body. Select the Concentrated Mass as the Independent 
Vertex/Point.  For the Dependent Entities, select the internal surfaces of the four holes on the 
top of the beam. 
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Step: 

Select OK to apply the connectors.   

NOTE: This will be an idealization of the motor base as if it were mounted to the beam.  The 
default definition for Rigid Connectors will have zero degrees of freedom available with respect 
to each other.  Uncheck the boxes to open these. 

Step: 

Select Generate Mesh in the Ribbon. 

Step: 

Run the analysis. 

Step:  

RMB on the Results and select Edit to view the mode shapes and corresponding frequencies.   

Note: XY Plots are automatically created for Frequency vs. Mode Number along with Translation 
and Rotation Effective Mass vs. Mode Numbers.   
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NOTE: Under XY Plot, the Effective Mass vs. Mode Number plot is reporting the vertical axis as a 
percentage of mass.     

That’s it!  You have completed the Modal analysis on a simple model.  Next you will look at a 
nonlinear analysis. 

 

Learn About FE Model Setup Using a Nonlinear Transient Response Analysis

Analysis Setup 
Let's look at a simple steel bar that will have an impulse load applied to one end.  The load will be 
applied over a very short time.  We will be looking at the response to this load and resulting stress with 
the resulting vibration after the load is relieved.   

User Interface 
 

Step: 

Open the folder NLTR – Bar and double click the [NLTR - Bar.ipj] file to launch Inventor. 

Step: 

Open [NLTR-Bar.ipt] 

Step: 

Switch to the In-CAD environment.   

Step: 

Edit the Analysis Type to be Nonlinear Transient Response and select OK. 
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NOTE: Changing the analysis type to Nonlinear Transient Response will show three new items in 
the browser.  You will see that Damping is added along with Nonlinear and Dynamics Setup.  You 
will look at Damping and Dynamics Setup later in this workflow but will leave Nonlinear Setup as 
the default settings.   
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Step: 

Create a fixed constraint at one end of the bar and select OK. 

Step: 

Apply a load to the other end using these values below. 

- Fx = 1 
- Fy = 1 
- Fz = 1  

Step: 

You might notice that a new section became available in the Load dialog called Transient Table 
Data.  Click the New icon to create a new load table. 

 

 

Step: 

Change the Type to Load Scale Factor vs. Time and input the data below and select OK. 

Time(s) Load Scale Factor 

0 0 

0.001 100 

0.002 0 

0.003 0 

 

NOTE: If you have the table data electronically, you can copy/paste into the load table.  Also, the 
extra zero load scale factor tells the Nastran solver that the load magnitude is zero for the rest 
of the analysis.  If you do not add this last zero, the solver will assume you want the load to 
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continue as a typical y=mx+b derived from the last two data points.  Setting these last two 
inputs to zero will make m=0 and b=0 in the equation. 

Step: 

Select OK to close the Load dialog and apply this to the active analysis. 

Step: 

Mesh the model using the default settings.  This should be coarse to reduce the analysis time. 

Step: 

Now let’s take a look at the Damping.  Double click on the Damping node in the Browser and 
uncheck Structural Damping. 

 

 

NOTE: For this example we are going to remove damping from the structure.  This can add 
significantly to the analysis time. 

Step: 

RMB on the Dynamics Setup node in the Browser and select Edit.  For the Interval Setup, leave 
as Duration.  Input .001 for the Time Step and 10 for the Number of Timesteps.  This should give 
you a 0.01 second simulation to see how the structure behaves during and after the impulse 
load.  Select OK to apply the changes. 
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That is it!  You have finished setting up a Nonlinear Transient Analysis Setup and are ready to 
run.   

Step: 

This will take around 5 minutes to solve.  If you are running out of time, browse to [NLTR – Bar-
Solved.ipj] to launch Inventor and open the [NLTR – Bar.ipt] file from this location.  RMB on the 
Results node in the Browser and select Load to add the saved results. 

   

Learn About Impact Analysis Setup and Results

Impact Analysis 
In this workflow you will perform an Impact Analysis on a thin tube.  You will learn about idealizing solids 
as shell elements.  You will also learn how to set the model up from scratch.  This will be helpful when 
you want to create multiple analyses in the document or to just start over. 

Impact Analysis Setup 
 

Step: 

Browse to the Impact Analysis folder and double click the [Impact Analysis.ipj] file to launch 
Inventor.   

Step: 

Open [Impact Analysis.iam] 

Step: 

Switch to the In-CAD environment.  Change the Analysis Type to be Impact Analysis. 
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Step: 

Looking in the browser, you will see two Physical Properties are created.  Modify the tube 
Physical Property and change the Type from Solid elements to Shell elements and add the outer 
face of the tube to the Selected Quadrilaterals section.  On the right side of the dialog, set t as 
0.125.  Click OK. 

 

Step: 

Mesh the model.   

Step: 

Create a Fixed constraint on the outer edge at one end of the tube and select OK. 

NOTE: The solid geometry for the tube is still shown but since it does not have a Physical 
Property defined it will be ignored. 

NOTE: The impact analysis requires a path for the projectile to travel on and an element node at 
each end of that path.  You will need to create mesh refinement points at the tube and plate. 

Step: 

Zoom into the gap between the two components and you will see a sketch line that will define 
the path.  To better view this area, switch to the view tab and use Half Section View. 
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Step: 

Select Mesh Control in the Mesh panel and add a mesh refinement to the vertices of the sketch 
line.  Set the Vertex Element Size to 0.1.  Hit OK to apply the Mesh control.  Rerun the Mesh 
Generator. 

 

Step: 

Switch back to the View tab and end section viewing if still active. 

Step: 

Under the Model Subcase, double click the Impact Setup to open the dialog.   

Step: 

Select the Plate as the Projectile Body. 
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Step: 

Now zoom into the sketch line again and select this as the Projectile Path.  After you select the 
sketch, it should show up in the dialog. 

 

 

Step: 

The next step is to verify the Projectile Path direction is correct.  Click the icon next to the 
Projectile Path and see if the arrows are pointing from the projectile body to the impacted 
object.  If not, reverse the direction by clicking the icon again. 
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Step: 

Add an Initial Velocity of 40 in/s then click OK to accept these changes. 

Step 

That’s it!  Click Run!  The model takes about 5 minutes to run.  If you have time, start the solving 
and watch the results as they are being calculated.  Once the analysis is complete, click OK and 
continue to post-processing the results below. 

If you do not want to wait, or running out of time, you can open the Impact Analysis-Solved 
folder and review the results on a solved model.  After opening, continue with the post-
processing results below. 

Step: 

If you opened the solved model, you will need to manually load the results.  RMB on the Results 
node in the Browser and select Multiset Animation Settings.  Below are some items you can 
change for better viewing of the results. 

- Looking at the Output Set on the left, set the End Set to the last Timestep. 
- In Contour Options, Set the Result Data to be SHELL VON MISES STRESS. 
- Check the Specify Min/Max box and set the Data Min to 30000. 
- Change the Deform Options to 30 Percent. 
- Edit the Part View and select the outer tube shell as the only visible component.  The 

projectile is bouncing off but you can leave this option unchecked if you want to see that 
also. 

Now select the Animate icon to start the Animation. 
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This will conclude the Lab.  Thank you so much for taking this lab and providing any feedback to us in the 
room.  If you have any questions after AU about this please email me at andrew.sears@autodesk.com.   

 

Thanks again! 

Andy Sears 

 

mailto:andrew.sears@autodesk.com

